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Ejercicio 1: La Evaluación de la Precisión 

Objetivos 

• Realizar una evaluación de la precisión de una imagen clasificada producida por 
Landsat  

• Construir una matriz de error 

Resumen de Temáticas 

• Repaso de estrategias de muestreo y puntos de referencia 
• Cómo agregar puntos de referencia a un mapa y extraer valores 
• Cómo crear una matriz de error y evaluar el nivel de precisión en la clasificación 

Herramientas Necesarias  

• Esri ArcGIS 10.x 
• Microsoft Excel 

Datos Asociados 

Por favor asegúrese haber descargado los datos necesarios y guárdelos en su 
computadora antes de hacer este ejercicio. Se puede encontrar los datos en la página 
en línea de ARSET aquí: https://arset.gsfc.nasa.gov/land/webinars/18adv-land-
classification. Los datos necesarios:  

• Imagen de Landsat 8 recortada y clasificada (guardada como 
Landsat_Classified.tif) 

o Esta imagen es del norte de California el 6 de abril de 2016. El nombre 
del archivo Landsat original es LC08_L1TP_028027_20160830. Ésta es 
una región rural, boscosa y fue clasificada usando seis distintos tipos de 
cubierta terrestre.  

• El archivo Reference_Points.shp 
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Introducción 

Para este ejercicio vamos a usar una imagen de Landsat 8 preclasificada y vamos a 
evaluar la precisión de ese mapa usando un conjunto de puntos de referencia. Esta 
imagen fue clasificada usando el método de clasificación supervisada.  

Para mayor información sobre cómo realizar una clasificación de la cubierta terrestre, 
por favor repase la capacitación ARSET en línea anterior: La Clasificación del Manto 
Terrestre a partir de Imágenes Satelitales aquí: 
https://arset.gsfc.nasa.gov/land/webinars/advanced-land-classification  

Ahora que tenemos una imagen de Landsat clasificada usando un método de 
clasificación supervisada, queremos hacer una evaluación cuantitativa del error. La 
evaluación de la precisión nos permite determinar cuánto la imagen clasificada coincide 
con datos de referencia adquiridos por otra fuente de información (ej. datos de campo, 
imágenes aéreas etc.). Específicamente, la “precisión" se prueba al comparar pixeles 
designados con la ubicación correspondiente en la imagen clasificada. Una de las 
razones principales por las que revisamos nuestra precisión o “error” es para 
determinar dónde ocurren errores y si la imagen debe ser re-muestreada. 

En este ejercicio, les hemos dado los datos de referencia. Estos datos de referencia 
fueron generados utilizando el método de muestreo aleatorio estratificado, el cual 
genera puntos aleatoriamente dentro de subáreas de alguna población o estrato. Aquí, 
le hemos hecho un mejoramiento a un método de muestreo aleatorio sencillo porque el 
número de puntos de referencia es proporcional a la superficie estimada de cada 
estrato. Por lo tanto, los estratos más grandes tendrán más puntos. Para hacer esto, 
utilizamos la herramienta de diseño muestral Sampling Design Tool para ArcGIS de la 
división Biogeográfica de la NOAA. 

Puede encontrar más información sobre la herramienta Sampling Design Tool aquí: 
https://www.arcgis.com/home/item.html?id=ecbe1fc44f35465f9dea42ef9b63e785  
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Esquema Metodológico 

 
Esquema metodológico para la evaluación de la precisión. 

  

Agregar Puntos de 
Referencia y 

Extraer Valores de 
los Puntos

Crear una Matriz 
de  Error

Calcular la 
Precisión de la 
Clasificación 

(Error)
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Parte 1: Configure su Área de Trabajo y Cargue los Datos Asociados 

1. Abra ArcMap en su computadora.  
a. En la parte inferior izquierda de la pantalla haca clic en el icono del 

Logotipo de Microsoft para abrir el menú de inicio. Seleccione Todos 
los Programas (All Programs), luego ArcGIS y después ArcMap 

2. Abra un nuevo mapa en blanco (Blank Map) 

Primero, asegúrese que la extensión Spatial Analyst esté activada. Esta extensión es 
importante para muchos procesos de teledetección que vamos a realizar en ArcMap. 

3. En la parte superior de la ventana, vaya a Customize > Extensions 
4. Haga clic en la casilla para Spatial Analyst 

Primero, vamos a cargar la imagen clasificada: 

5. En la barra de herramientas, haga clic en el icono Add Data  
6. Navegue a su carpeta de Evaluación de la Precisión (Accuracy Assessment) y 

agregue la imagen Landsat_Classified.tif 
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Ahora, cambiaremos los nombres de nuestras categorías de cubierta terrestre y 
cambiaremos el esquema cromático para que sea más intuitivo. 

7. Haga clic con el botón derecho en el archivo Landsat_Classified en la lista Table 
of Contents y haga clic en Properties 

8. Haga clic en la pestaña Symbology y ahora haga clic en Unique Values en el 
panel a la izquierda debajo de Show 

9. Haga clic en cada etiqueta y cámbiele el nombre para que coincida con nuestras 
categorías de cubierta terrestre:  

a. Water (Agua) 
b. Agriculture (Agricultura) 
c. Hardwood (light forest)/ Latifoliado (bosque iluminado) 
d. Conifer (dark forest)/ Conífero (bosque oscuro) 
e. Grass/shrub (Pastizal/matorral) 
f. Bare ground (Suelo descubierto) 
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10. Cambie los colores haciendo clic en el icono del color de cada categoría. Elija 
colores que parezcan lógicos. Haga clic en Apply y en OK. 

Guardando su documento ArcMap  

Siempre es buena práctica guardar su mapa mientras vaya trabajando. 

11. Vaya a la parte superior de la ventana de ArcMap y haga clic en File > Save As 
12. Guarde su archivo como Accuracy_Ex1.mxd (la extensión se agregará 

automáticamente) en su carpeta Accuracy Assessment. 
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Agregando sus Puntos de Referencia 

Idealmente, cuando uno realiza una evaluación de la precisión, tiene datos recopilados 
en el campo. Éstos informan la “verdad en el suelo” para la clasificación. Para este 
ejercicio usaremos datos de referencia simulados como la “verdad en el suelo.”  

13. En la barra herramientas haga clic en el icono de Add Data  
14. Navegue a su carpeta Accuracy Assessment y agregue el archivo 

Reference_Points.shp 
15. En la lista Table of Contents, haga clic con el botón derecho en 

Reference_Points y haga clic en Properties. Haga clic en la pestaña 
Symbology. A la izquierda, haga clic en Categories > Unique values. 

16. Bajo Value Field, seleccione LandCover. Ahora haga clic en el botón Add All 
Values. Haga clic en Apply y después en OK. 

Esto mostrará los puntos de referencia para todos los valores. Debe haber seis clases 
de puntos de referencia, igual que en su imagen clasificada de Landsat (agua, 
agricultura etc.). 
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Parte 2: Extraiga los Valores de Pixel para Cada Punto de Referencia 

Ahora que hemos cargado los mismos puntos, queremos obtener el valor de pixel para 
cada uno para compararlos con nuestra imagen clasificada.  

1. Navegue a la herramienta Extract Values to Points en el 
ArcToolbox (Spatial Analyst Tools > Extraction > Extract 
Values to Points). Esta herramienta extrae el valor en 
pixel para cada punto. 

2. Para Input point features, seleccione Reference_Points. 
Para Input raster, navegue a su carpeta Accuracy 
Assessment y seleccione Landsat_Classified.tif. Guarde 
el resultado como Values.shp en su carpeta Accuracy 
Assessment y haga clic en OK. 

3. Una vez que acabe el procesamiento, debe ver el nuevo archivo agregado a su 
mapa. En la lista Table of Contents, haga clic con el botón derecho en el 
archivo Values.shp y haga clic en Open Attribute Table. Verá los nuevos 
valores clasificados en el campo RASTERVALU. 
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Los nombres “RASTERVALU” y “Values” no son muy explicativos, así que 
cambiémosle el nombre a las columnas.  

4. Haga clic en Table Options  y seleccione Add 
Field. A este campo llámelo Classified. Para type, 
seleccione Short Integer y haga clic en OK. 

5. Cuando aparezca la columna, haga clic con el botón 
derecho en la nueva columna Classified y haga clic 
en Field Calculator. Puede que vea una 
advertencia diciendo “You are about to do a 
calculation outside of an edit session…” Haga clic en 
Yes. 

6. En la sección Fields del Field Calculator, haga doble clic en RASTERVALU y 
haga clic en OK. Esto transferirá la información de la columna RASTERVALU a 
la columna Classified 

7. Haga lo mismo con Values para cambiarle el nombre a Reference 
8. Seleccione Add Field, cámbiele el nombre a Reference. Para type, seleccione 

Short Integer. Haga clic en la columna Reference, vaya al Field Calculator, 
seleccione Values, y haga clic en OK. 
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9. Borre las columnas RASTERVALU y Value. Para hacer esto, haga clic con el 
botón derecho en la columna RASTERVALU y seleccione Delete Field. Cuando 
vea la advertencia Confirm Delete Field, haga clic en Yes. 

10. Para mayor claridad, ordene la tabla basándose en las categorías de cubierta 
terrestre que especificamos en nuestra imagen clasificada. Haga clic con el 
botón derecho en la columna Reference y haga clic en Sort Ascending 

La tabla Values.shp debe verse así:  
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Parte 3: Calcular Frecuencia 

Ahora que tenemos los valores de los puntos de referencia, queremos aislar los valores 
de frecuencia para la imagen clasificada y los puntos de referencia. 

1. Cierre la tabla de atributos (Attribute Table) 
2. Navegue a la herramienta Frequency en el ArcToolbox (Analysis Tools >  

Statistics > Frequency). 
3. En la tabla Input Table, seleccione el archivo Values. Esto automáticamente 

cargará las columnas de la Attribute Table. En la Output Table, navegue a su 
carpeta Accuracy Assessment y guarde el archivo como Frequency_Table.dbf. 
Para los campos Frequency, seleccione Classified y Reference. Deje los 
campos Summary Field(s) sin seleccionar. Haga clic en OK. 

4. Una vez que el proceso se haya completado debería haber un Frequency_table 
debajo del archivo Values en la lista Table of Contents. Haga clic con el botón 
derecho en Frequency_table y haga clic en Open.  
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a. Esta tabla nos muestra cuántos pixeles se predijeron correctamente en la 
imagen de Landsat por cada punto de referencia (la “verdad en el suelo). 
La tabla de frecuencias nos da algo de información, pero sigue siendo 
difícil de leer. Pongámosla de una manera más fácil. Cierre la tabla.  

Ingrese la Frecuencia a una Tabla Dinámica (Pivot Table) 

En estos próximos pasos, crearemos una tabla dinámica para ordenar y visualizar las 
frecuencias.  

5. Navegue a la herramienta de tablas dinámicas Pivot Table tool (Data 
Management Tools > Table > Pivot Table). 

6. Para la Input Table, seleccione Frequency_Table. Para Input Fields, 
seleccione Classified. Para Pivot Field, seleccione Reference. Para el cambio 
de valor (value), seleccione FREQUENCY. Esto creará una nueva tabla con 
valores de la clasificación como filas, puntos de referencia como columnas y la 
frecuencia de los valores en cada una de las células. Guarde como 
Error_Matrix.dbf y haga clic en OK. 
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7. Una vez que termine el proceso, la tabla Error Matrix se agregará a su mapa. En 
la lista Table of Contents, haga clic con el botón derecho en Error_Matrix y 
seleccione Open. 

8. Ud. verá una tabla con seis tipos de clases de cubierta terrestre y seis columnas 
de puntos de referencia. Cierre la tabla Error_Matrix. 

Exporte la Mesa Dinámica a Excel 

9. Navegue a la herramienta Table to Excel tool (Conversion Tools > Excel > 
Table to Excel). 

10. Para la Input Table, seleccione Error_Matrix. Para el Output Excel File, haga 
clic en la carpeta y guarde como Error_Matrix.xls en su carpeta Accuracy 
Assessment y haga clic en OK. 

11. Una vez que termine el proceso, cierre la ventana Table. Si es que aún no lo ha 
hecho, guarde su documento ArcMap como Accuracy_Ex1.mxd  



Capacitación en Linea Avanzada: La Evaluación de la Precisión de una 
Clasificación de la Cubierta Terrestre 
13 y 20 de febrero de 2018 
 

http://arset.gsfc.nasa.gov/   14  

Parte 4: Calculando el Error en Excel 

La precisión de una imagen normalmente reporta el porcentaje que está correcto. 
Como se mencionó en la presentación, hay diferentes tipos de precisión. Aquí vamos a  

calcular la precisión global, la precisión del usuario y la procesión del productor. 

1. Minimice su ventana de ArcMap y abra Microsoft Excel 
2. Navegue a la carpeta Accuracy Assessment y abra su archivo Error_Matrix  

Ésta es su matriz de error (también llamada “matriz de confusión”). La matriz de error 
mostrará sus datos de referencia en columnas y los datos de su clasificación en filas o 
líneas. Debe verse así:  

Las clases aún están anotadas como números, así que cambie los números por 
nombres bajo la columna Classified y para que cada etiqueta “Reference” corresponda 
con su tipo de clase (ej., Reference1 como Agua, Reference2 como Agricultura etc.). 
Puede referirse al principio de este ejercicio para todos los tipos de clases.  

3. Borre la columna OID 

Su tabla debería verse así:  
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4. Agregue una columna llamada Total Reference Points al final y sume los 
valores de izquierda a derecha. Use la función SUM para sumar todas las 
células horizontalmente. Esto sumará todos los puntos de referencia para cada 
tipo de cubierta terrestre.	 

Haga clic en la parte inferior derecha de la célula y arrastre hacia abajo para aplicarle la 
misma ecuación a cada línea. 

5. Agregue una fila llamada Total Classified Points al fondo de la columna 
Classified y sume los valores para cada columna (Agua, Agricultura etc.). Haga 
clic en la punta inferior derecha de la célula y arrastre horizontalmente para 
aplicarlas a la misma ecuación. Esta columna muestra el número de pixeles 
clasificados para ese tipo de cubierta terrestre.		 
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6. Después de sumar horizontal y verticalmente, su tabla debería verse así:   

7. Para calcular el error, queremos sumar los valores de los pixeles correctamente 
indicados y dividir por el número total de puntos de referencia. 

8. Debajo de su tabla (salte una fila para no confundirse) haga una nueva fila y 
llámela Total Correct Reference Points 

a. Para calcular el total de puntos de referencia correctos, use la ecuación 
SUM y presione CTRL para agregar los valores diagonalmente 
(resaltados). Si se fija en la tabla, éstos son el número de pixeles que 
fueron clasificados igual que los puntos de referencia (Agua/Agua, 
Agricultura/Agricultura)	 

9. Haga otra célula y llámela Total “True” Reference Points. Éste es el número 
total de pixeles incluidos en sus puntos de referencia (casilla azul abajo). Éste es 
el valor en la última fila bajo Total Reference Points. Así que en la fila al lado 



Capacitación en Linea Avanzada: La Evaluación de la Precisión de una 
Clasificación de la Cubierta Terrestre 
13 y 20 de febrero de 2018 
 

http://arset.gsfc.nasa.gov/   17  

de Total “True” Reference Points, teclee el signo igual (=) y haga clic en esa 
célula (H8).  

10. Agregue una fila llamada Percent Accuracy (salte una línea debajo de Total 
“True” Reference Points para evitar confundirse). Para calcular el porcentaje 
de precisión, divida su total de puntos de referencia correctos por su total de 
puntos de referencia “verdaderos” y multiplique este resultado por 100. 

Porcentaje de Precisión = [Total de puntos de referencia correctos / Total de puntos de 
referencia “verdaderos”]*100 

11. Para este ejemplo el porcentaje de precisión es de un 78 por ciento. El 
porcentaje de precisión explica cuan precisa fue su clasificación; es decir, el 
porcentaje de puntos de referencia correctamente clasificados del total de 
puntos de referencia. Esto también se llama el “porcentaje de error.”  

12. Guarde su archivo Excel. 
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Errores de Omisión y de Comisión 

También podemos cuantificar la precisión de clases individuales mediante el cálculo de 
errores de comisión (precisión del usuario) y de omisión (precisión del productor). Los 
errores de comisión ocurren cuando un pixel se incluye incorrectamente en una 
categoría que se está evaluando, mientras que los errores de omisión ocurren cuando 
un pixel se excluye de la categoría que se está evaluando. 

Primero, comenzaremos con la precisión del usuario (errores de comisión). 

13. Agregue una fila llamada User’s Accuracy (salte una línea debajo de Percent 
Accuracy para no confundirse). 

14. Copie cada una de las clases de cubierta terrestre y péguelas bajo User’s 
Accuracy 

15. La precisión del usuario se calcula dividiendo el número diagonal por el total de 
la fila y multiplicándolo por 100. Ingrese este cálculo para cada clase de cubierta 
terrestre.	 
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16. Cambie el formato de las células para cada una de las precisiones del usuario 
para mostrar dos dígitos después del decimal. Resalte todas las células, en la 
parte superior haga clic en Format > Cells. Bajo Category, haga clic en 
Number y al lado de Decimal Places ingrese 2. Haga clic en OK. 

17. Para mantener la hoja de Excel organizada, combine y centre las células 15A y 
15B. Resalte ambas células y haga clic en la función Merge and Center. 

 Ahora haga el color de fondo para esa célula el mismo que el de 
las etiquetas en la parte superior de la hoja.  

Hagamos lo mismo para el error del productor (errores de omisión).  

18. Copie las clases a la columna D (empezando con D16, vea abajo). Cree otra 
etiqueta llamada Producer’s Accuracy en la columna D. Así como hizo en el 
paso anterior, realice la función Merge and Center con la célula de Producer’s 
Accuracy (D15) y la célula a la derecha (E15) y asegúrese que tenga el mismo 
color de fondo que las otras etiquetas.  

19. La precisión del productor se calcula dividiendo el número diagonal por el total 
de la columna y multiplicando por 100. Ingrese este cálculo para cada clase de 
cubierta terrestre.  
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20. Como lo hizo anteriormente, cambie el formato de las células para cada una de 
las precisiones del usuario para mostrar dos dígitos después del decimal. 

Ahora puede ver cuán precisa es su clasificación para cada clase de cubierta terrestre 
y si el mapa tiene más errores de comisión o de omisión. Por ejemplo, se puede ver 
que la precisión del usuario es más baja para la categoría Agricultura y pareciera que 
la clasificación incluyó pixeles clasificados como Suelo Descubierto en esa categoría. 
Éste es un error común y resalta la diferencia entre el uso del suelo y la cubierta 
terrestre. Es probable que los pixeles designados como Suelo Descubierto incluidos 
en esta categoría se hayan usado alguna vez para la Agricultura y posiblemente se 
hubieran dejado en barbecho en ese momento.  
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Conclusión 

La evaluación de la precisión es un paso importante en el análisis de su clasificación de 
la cubierta terrestre. Este ejercicio le dio una idea de cómo realizar una evaluación de 
la precisión de una imagen clasificada. Usted extrajo valores de pixel para puntos de 
referencia, creó una matriz de error, calculó la precisión global como porcentaje y las 
precisiones del usuario y del productor. La evaluación de la precisión es una buena 
oportunidad de determinar si uno debe re-muestrear su clasificación o si puede avanzar 
con su análisis. La próxima semana nos vamos a enfocar en el error estándar en 
nuestra clasificación y vamos a realizar algunos procesos estadísticos más 
complicados.  

Recursos en Línea Adicionales (en inglés) 
 

Organización de las Naciones Unidas para la Agricultura y la Alimentación (FAO): Map 
Accuracy Assessment and Area Estimation (Evaluación de la Precisión y Estimación de 
la Superficie de los Mapas): http://www.fao.org/documents/card/en/c/e5ea45b8-3fd7-
4692-ba29-fae7b140d07e/ 

Evaluación de la Precisión de la Clasificación de Una Imagen en ArcMap en la 
Universidad Agricultura y Mecánica de Tejas: 
https://www.youtube.com/watch?v=FaZGAUS_Nlo 

Creación de una Evaluación de la Precisión: 
http://desktop.arcgis.com/en/arcmap/latest/tools/spatial-analyst-toolbox/create-
accuracy-assessment-points.htm  


